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Szanowni Państwo ! 
 
Oddajemy do rąk  Państwa kolejną wersję naszego dokumentu opisującego zagadnienia związane z 
korzystaniem z oprogramowania SAS w polskich warunkach czyli aspekty lokalizacyjne SAS-a. 
Niniejsza jego wersja jest  zmodyfikowaną i rozbudowaną kontynuacją poprzednich, przygotowanych 
dla wersji 8.0 i 8.1.  Tym razem dostarczamy Państwu dokumentu wraz z dystrybucją v8.2 (TS2M0) 
na Windows. 
Wszystkie testy wykonaliśmy ponownie i zweryfikowaliśmy zgodność wszelkich informacji z 
rzeczywistością wersji 8.2  Testy przeprowadzaliśmy w standardowych środowiskach Windows i Unix. 
 
Oprogramowanie SAS w wersji 8.x naturalnie dostosowuje się do naszych czcionek, systemów 
kodowania polskich znaków itd. Niniejszy dokument wskazuje na napotkane przez nas na etapie 
testów odstępstwa od tej zasady, wymagające takiej czy innej uwagi.  
 
„Polonizacja wersji 8.x Systemu SAS” powinna zostać udostępniona każdej osobie stykającej się z 
zagadnieniami związanymi z polskimi znakami w tworzonych aplikacjach. Uważna lektura może 
oszczędzić niemało wysiłku w czasie tworzenia aplikacji. 
 
Dokument i inne informacje związane z tematem będą publikowane na naszych stronach WWW pod 
adresem: 

 
http://www.sas.com/poland/centrum.htm 

 
W razie dodatkowych pytań prosimy o kontakt z naszym Zespołem, telefonicznie na numer 
(22) 5604666 lub elektronicznie pod adresem hotline@spl.sas.com.  
 
Prosimy o uwagi i spostrzeżenia, które pomogą nam w przygotowaniu następnych wersji tego 
dokumentu. 
 
 
 

Zawsze służąc Państwu pomocą, 
 

Zespół Pomocy Technicznej  
Centrum Technologii   
SAS Polska 
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1. BASE 
 
1.0.  Nie zapomnij o opcji locale! 
Ustaw opcję locale Polish albo w sasv8.cfg, albo w linii wywołania SAS-a. 
Bez ustawienia opcji locale w wielu sytuacjach „ogonków” będzie brakować.  
 
W v8.2 występuje problem z uruchomieniem przez tego samego użytkownika drugiej sesji SAS-a z 
ustawioną opcją locale. Druga sesja nie uruchamia się, pojawia się komunikat o zablokowanym przed 
zapisem biblioteką SASUSER. Najprostszym rozwiązaniem problemu jest ustawienie opcji rsasuser 
dla wszystkich sesji SAS-a, np. w configu: 
 
-locale Polish 
-rsasuser 
 
Upewnić się czy sasowa opcja jest ustawiona można np. w poniższy sposób: 
 
proc options option=locale; 
run; 
 
 
1.1. DMS – Display Manager 
W okienkach Program Edytor, Log, Output  wyświetlane będą polskie znaki jeżeli wybierzemy dla nich 
czcionkę (typu monospace), która polskie znaki posiada. Wybór przez Tools-> Options-> Fonts. 
Czcionki z polskimi znakami, to te dla których można wybrać skrypt ‘Europa Środkowa’. Problemy z 
FontSubstitutes, które występowały w v6 nie są już aktualne (nabyte doświadczenie może się przydać 
w przypadku problemów z Enterprise Guidem). 
Warto pamiętać, że rozszerzenia CE w nazwach czcionek nie są przez SAS-a obsługiwane.  
 
Czcionkę w Enhanced Edytorze wybieramy przez Tools-> Options-> Enhanced Editor-> Appearance z 
listy wszystkich dostępnych w systemie operacyjnym czcionek. Odpowiedni skrypt dla Polski to 
‘Central European’.  
 
Powyższe ustawienia są automatycznie zapamiętywane przy końcu sesji, jeżeli jest zaznaczony check 
box „Save setting on exit” w Tools-> Options-> Preferences. 
 
 
1.2 Polskie sortowanie. 
Chcąc sortować po polsku, należy przede wszystkim upewnić się, czy został wykonany punkt 1.0. 
 
Aby posortować po polsku należy ustawić (jeżeli wcześniej ktoś już nie ustawił) w Solutions -> 
Accessories -> Locale Setup: Polish (warto w zakładce Other options zaznaczyć check box TRANTAB 
NAME). Po OK zostanie utworzona m. in. polska tablica sortowania o nazwie Polish (w v8.2 
nieprawidłowa) (SASUSER.PROFILE.POLISH.TRANTAB). Tablicę tę można wybrać jako opcję proc 
sort lub proc sql: sortseq=polish.  
 
W v8.2 trantab Polish jest nieprawidłowy. Prawidłowy (archiwum ZIP) można ściągnąć z: 
http://www.sas.com/offices/europe/poland/wsparcie/dw/cat_polish.zip  
i skopiować do biblioteki SASUSER lub samemu wyprodukować (za pomocą odpowiedniego makra). 
Jeżeli mamy dostępną wersję v8.0, to prawidłowy trantab Polish można też z niej  skopiować.  
Prawidłowym trantabem należy nadpisać błędny, automatycznie wygenerowany.  
Zarówno wspomniane makro jak i prawidłowy trantab można też oczywiście otrzymać, kontaktując się 
z nami przez hotline. 
 
Tak można sprawdzić czy sortowanie działa prawidłowo. 
 
data t; 
  length dane $20; 
  input dane @@; 
  cards; 
zbir żuk Monika ą źdźbło maszyna Lew łopata Ą Ala analiza lewica Łódź Adam 
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; 
run; 
proc sort data=t  sortseq=polish; 
by dane; 
titl 1 'Zb
proc print; 

e iór po posortowaniu standardowym - komputerowym'; 

run; 
 
Procedura SORT powinna, po ustawieniu opcji sortseq, wykonywać polskie sortowanie komputerowe 
AĄBCĆ...aąbcć . W przypadku potrzeby sortowania słownikowego lub w dowolnym innym porządku 
udostępniamy makro, które stworzy potrzebną tablice sortowania. 
 
Aby polskie sortowanie uczynić domyślnym, należy skopiować obiekt TANTAB SASUSER.PROFILE. 
POLISH.TRANTAB do tego samego katalogu pod nazwą National i wskazać go ustawiając opcję 
sortseq (ustawienie polish się nie uda). 
 
options  sortseq=National; 
 
 
1.3 Polskie formaty daty. 
Chcąc korzystać z polskich formatów daty, należy przede wszystkim upewnić się, czy został 
wykonany punkt 1.0.  Ustawienie opcji locale spowoduje automatyczne ustawienie opcji dflang na 
’Polish’. 
Wtedy polskie formaty daty można uzyskać wykonując poniższy kod. 
 
data _null_; 
data='1jan1960'd; 
put data DATE.; 
put data POLDFDE.; 
put data POLDFDT.; 
put data POLDFDWN.; 
put data POLDFMN.; 
put data POLDFMY.; 
put data POLDFWKX.;   
put
run; 

 data POLDFWDX.; 

 
Brak polskich czcionek w wynikach wykonania powyższego programu (jeżeli nie jest spowodowany 
nieustawieniem opcji locale) może być spowodowany pomyłką w pakiecie instalacyjnym (wczesne 
wersje kompaktów). Znaki polskie w formatach daty pojawią się wówczas po podmianie: 
!SASROOT\core\sasmsg\core.msg prawidłowym plikiem. Prawidłowy core.msg można ściągnąć spod 
adresu: 
http://www.sas.com/offices/europe/poland/wsparcie/dw/core_msg_SAS8_1.zip 
   
 
1.4 ODS 
 

1.4.1 RTF 
ODS RTF z polskimi znakami, dla którego trzeba było stosować obejście w v8.1, w 8.2 działa 
prawidłowo (po ustawieniu opcji locale jak w punkcie 1.0). 
 
1.4.2 PDF 
Wersja 8.2 nie pozwala na generowanie plików w formacie pdf zawierających polskie znaki. Nawet z 
włączoną opcją locale polish. 

 
 
1.5 Explorer (SAS-owy). 
 
Sortowanie Windows-owych folderów lub plików (w Favorite Folders i przez View-> Details) nie działa 
po polsku. 
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1.6 Polskie drukowanie. 
Chcąc drukować po polsku, należy przede wszystkim upewnić się, czy został wykonany punkt 1.0. 
 
Jeżeli na wydruku nie ma polskich czcionek, to należy w ustawieniach drukarki File-> Print-> Setup-> 
Font zmienić czcionkę na taką, która polskie znaki posiada (np. Times New Roman). Nowa czcionka 
zostanie zapamiętana  jako domyślna czcionka dla drukowania. Taki sam skutek – polskie znaczki na 
wydruku będzie miało ustawienie opcji sysprintfont: 
 
options sysprintfont=’Arial' 10; 

 
 
2. GRAPH 
 
Wersja 8 znakomicie ułatwia pracę z czcionkami  przy wykorzystaniu oprogramowania SAS/GRAPH. 
Poniżej przedstawiamy wskazówki dotyczące używania nowej funkcjonalności. 
 
 
2.1 Czcionki systemowe (HARDWARE FONTS). 
Nie są już potrzebne żadne dodatkowe zabiegi aby skorzystać z czcionek TrueType dostępnych w 
systemie operacyjnym (Windows). Jeżeli korzystamy z polskiej wersji Windows 95, Windows NT, czy 
Windows 2000 to bez żadnych problemów uzyskamy pożądane efekty po prostu używając nazw 
czcionek jako wartości odpowiednich opcji. Dodając do nazwy czcionki /bo uzyskamy pogrubienie a /it 
czcionkę pochyłą.  
Przykładowy program demonstrujący użycie czcionek: 
 
libname GR '.'; 
data GR.klasa; 
  length wzrost 8 kategoria $ 10; 
  input  wzrost kategoria $; 
  kategoria_u=upcase(kategoria);  kategoria_l=lowcase(kategoria); 
  label kategoria_u='Kat. ąęćłńóśźż'   kategoria_l='Kat. ĄĘĆŁŃÓŚŹŻ'; 
cards; 
181     Liść 
167     Sęk 
180     Źdźbło 
181     Źdźbło 
172     Kość 
181     Dąb 
; 
run; 
 
goptions reset=all; 
title1 ftext='Times New Roman/it' h=10 pct 'Kat. ąęćłńóśźż'; 
title2 ftext ='Tahoma/bo'  'Kat. ĄĘĆŁŃÓŚŹŻ';  h=6 pct
legend1 label=(font='Arial/bo/it' 'Legenda ĄĘĆŁŃÓŚŹŻ') 
        value=(font='Arial/it/' height=1.5 pct); 
axis1   label=(font='Tahoma/bo/it' 'Axis ĄĘĆŁŃÓŚŹŻ');      
goptions ftext='Arial'; 
proc gchart data=gr.klasa; 
  vbar kategoria_l /type=mean sumvar=wzrost  
        maxis=axis1 
        subgroup=kategoria_u legend=legend1; 
  run; 
quit; 
 
Uzyskana na ekranie grafika zostanie poprawnie wydrukowana zapisana w jednym z wielu formatów 
graficznych (m.in. GIF, WMF, JPEG). Bez żadnych problemów można ją też użyć w aplikacjach 
SAS/AF i SAS/EIS.  
W identyczny sposób (zmieniając jedynie docelowe urządzenie)  możemy wygenerować grafikę 
bezpośrednio na drukarkę lub do pliku zewnętrznego. 
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2.2 Czcionki SAS/GRAPH (SOFTWARE FONTS). 
Nowa wersja pozwala (tym razem niezależnie od systemu) na wykorzystanie niektórych czcionek 
SAS/Graph do produkcji grafiki z polskimi literami. Czcionki zawierające nasze „ogonki” to CENTX, 
SWISS, ZAPF. Te właśnie nazwy powinny zostać użyte w specyfikacjach czcionek. Dodatkowo należy 
ustawić odpowiednią tablicę przekodowań (keymapę) ze strony systemowej (Windows 1250, iso8859-
2) na wewnętrzną stronę kodową SAS/GRAPH. Tablicę przekodowań tworzymy wykonując poniższy 
kod, ale najpierw musimy dowiązać bibliotekę o nazwie gfont0, w której zostanie wygenerowana 
tablica przekodowań (kod na następnej stronie). 
 

/* generowanie keymapy dla WINDOWS */ 
libname gfont0 (sashelp); 
 
proc gkeymap name=winansi out=temp keymap; 
run; 
data mod; 
    retain tolen 1; 
    from="d3"X;TO="08"x;output;  /* Oacute   */ 
    from="f3"X;TO="a2"x;output;  /* oacute   */ 
    from="f1"X;TO="c0"x;output;  /* nacute   */ 
    from="d1"X;TO="c1"x;output;  /* Nacute   */ 
    from="9c"X;TO="c2"x;output;  /* sacute   */ 
    from="8c"X;TO="c3"x;output;  /* Sacute   */ 
    from="9f"X;TO="c4"x;output;  /* zacute   */ 
    from="8f"X;TO="c5"x;output;  /* Zacute   */ 
    from="bf"X;TO="c6"x;output;  /* zdot     */ 
    from="af"X;TO="c7"x;output;  /* Zdot     */ 
    from="b3"X;TO="c8"x;output;  /* lslash   */ 
    from="a3"X;TO="c9"x;output;  /* Lslash   */ 
    from="b9"X;TO="ca"x;output;  /* ahook   */ 
    from="a5"X;TO="cb"x;output;  /* Ahook   */ 
    from="ea"X;TO="cc"x;output;  /* ehook   */ 
    from="ca"X;TO="cd"x;output;  /* Ehook   */ 
    from="c6"X;TO="f4"x;output;  /* Cacute  */ 
    from="e6"X;TO="f9"x;output;  /* cacute  */ 
run; 
proc sort data=mod; by from; 
run; 
data temp; 
  update temp mod; by from; 
run; 
proc gkeymap name=win1250 data=temp keymap; 
run; 

/* generowanie keymapy dla UNIXa */ 
libname gfont0 '.'; 
 
proc gkeymap name=Latin2 out=temp keymap; 
run; 
data mod; 
    retain tolen 1; 
    from="d3"X;TO="08"x;output;  /* Oacute   */ 
    from="f3"X;TO="a2"x;output;  /* oacute   */ 
    from="f1"X;TO="c0"x;output;  /* nacute   */ 
    from="d1"X;TO="c1"x;output;  /* Nacute   */ 
    from="b6"X;TO="c2"x;output;  /* sacute   */ 
    from="a6"X;TO="c3"x;output;  /* Sacute   */ 
    from="bc"X;TO="c4"x;output;  /* zacute   */ 
    from="ac"X;TO="c5"x;output;  /* Zacute   */ 
    from="bf"X;TO="c6"x;output;  /* zdot     */ 
    from="af"X;TO="c7"x;output;  /* Zdot     */ 
    from="b3"X;TO="c8"x;output;  /* lslash   */ 
    from="a3"X;TO="c9"x;output;  /* Lslash   */ 
    from="b1"X;TO="ca"x;output;  /* ahook   */ 
    from="a1"X;TO="cb"x;output;  /* Ahook   */ 
    from="ea"X;TO="cc"x;output;  /* ehook   */ 
    from="ca"X;TO="cd"x;output;  /* Ehook   */ 
    from="c6"X;TO="f4"x;output;  /* Cacute  */ 
    from="e6"X;TO="f9"x;output;  /* cacute  */ 
run; 
proc sort data=mod; by from; 
run; 
data temp; 
  update temp mod; by from; 
run; 
proc gkeymap name=pbUNIX data=temp keymap; 
run; 

 
A oto przykładowy kod, korzystający z polskich znaków: 
 
goptions reset=all; 
libname gfont0 (sashelp); 
goptions keymap=win1250; 
proc gslide; 
  note f=swiss  h=3 ‘Żołądek’; 
  run; 
quit; 
 
 
2.3 Mapa Polski z nowym podziałem administracyjnym. 
Podstawowy zbiór z mapą - Poland przedstawia podział na powiaty. Dostępny jest również zbiór 
Poland2, który zawiera powiązania powiatów z województwami. Aby otrzymać mapę z 
województwami należy odpowiednio te dwa zbiory połączyć. Następnie użyć procedury GREMOVE, 
aby usunąć granice powiatów. Przedstawia to poniższy kod: 
 
goptions reset=all; 
proc sql; 
create table poland as 
select polska2.wojid as wojid, polska1.id as segment, polska1.x as x, 
polska1.y as y, polska1.lat as lat, polska1.long as long, polska2.idname as 
powname 
from maps.poland polska1, maps.poland2 polska2 where polska1.id=polska2.id; 
quit; 
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proc gremove data=poland out=poland;  
id wojid;  
by wojid;  
run; 

 
Aby zobaczyć nową mapę w SAS-ie można np.: 
 
data dane; 
do i=1 to 16; 
  wojid=i; value=i;  
  output; 
end; 
drop i; 
run; 
 
goptions reset=all; 
proc gmap data=dane map=poland; 
id wojid; 
choro value/levels=16; 
run; 
quit; 

 
 
3. CONNECT i SHARE 
 
Aby przenosić polskie znaki między platformami sprzętowymi należy po stronie klienta i serwera 
upewnić się, czy zostały wybrane polskie ustawienia lokalne (Solutions -> Accessories -> Locale 
Setup: Polish). Ich wybranie powoduje, że mamy do dyspozycji (są utworzone w bibliotece SASUSER) 
odpowiednie trantaby (tablice translacji). Tablice translacji zawierające polskie znaki powstają łącznie 
z tablicą sortowania (p. 1.2). Są one odpowiednikami standardowych tablic _0000xxx i mają ich 
nazwy. Aby ułatwić korzystanie z nich, polecamy przy ich generacji (podobnie jak w 1.2) w ->Options 
zaznaczyć „Trabase naming convension”. Wówczas dodatkowo powstaną kopie trantabów z nazwami 
literowymi Polxty, które łatwej będzie rozszyfrować dzięki opisom.   
W wersji 8.2 zostały poprawione występujące w poprzednich wersjach problemy z błędami w tablicach 
translacji wykorzystywanych przez RLS. 
W celu ustawienia polskich tablic translacji tak, aby były globalnie używane przez wszystkich 
użytkowników, prosimy o skontaktowanie się z hotline. 
Więcej informacji na temat tablic translacji można uzyskać z dokumentu: 
http://ftp.sas.com/techsup/download/technote/ts639.pdf 
 
 
4. AF i EIS 
 
4.1 Prezentacja grafiki SAS/Graph 
Obiekty SAS/Graph Output i Graph Output Control bez problemów pokazują grafikę z polskimi 
znakami wygenerowanymi przy użyciu czcionek sprzętowych i wymienionych w punkcie 2.2 czcionek 
SAS/Graph. Obiekty Graphic Text i Graphic Text Control wyświetlają listę czcionek obejmującą 
czcionki z punktu 2.2 i pozwalają na używanie polskich znaków pod warunkiem odpowiednich 
ustawień opcji KEYMAP (p. 2.2).   
 
 
4.2 Drukowanie na przykładzie raportu Multidimensional Report. 
Gdy będziemy drukowali raport typu Multidimensional Report ze standardowymi ustawieniami, na 
wydruku znajdzie się domyślna czcionka z DMS-a czyli SAS Monospace (z domyślnym rozmiarem), 
która polskich znaków nie posiada. Ustawienie domyślnej czcionki do drukowania opisano w punkcie 
1.6. 
 
 
5. MDDB 
 
Na razie nie ma możliwości skorzystania przy tworzeniu MDDB z ustawionej opcji SORTSEQ. Jeżeli 
chcemy, by zmienne klasyfikujące były przechowywane posortowane w zbiorze MDDB to w deklaracji 
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CLASS należy użyć opcji DSORDER, a zbiór na podstawie którego tworzymy MDDB wcześniej 
posortować (p. 1.2). 
 
 
6. UNIX 
 
W niniejszych podpunktach znajdziecie Państwo odpowiedź jak stosować polskie znaki podczas pracy 
z SAS-em w środowisku graficznym UNIX, czyli X-Windows. Należy przy tym pamiętać, iż 
posługiwanie się polskimi znakami to 2 niezależne od siebie czynności: 

- możliwość zobaczenia polskich znaków 
- możliwość wpisywania z klawiatury polskich znaków 

 
6.1. Jak zobaczyć polskie znaki w SAS-ie? 

a. Aby polskie znaki były widoczne w środowisku graficznym UNIX, muszą być udostępnione 
przez serwer X-Windows. W celu ustalenia nazwy polskiego fontu udostępnianego przez 
serwer X-Windows, należy pasku poleceń SAS wpisać polecenie „fontlist”, 
kliknąć na przycisk „System”, zaznaczyć font, który posiada w nazwie iso8859-2 i zatwierdzić 
<OK.>. Następnie należy skopiować (do schowka) tę nazwę klikając, na przycisk <Copy>.  
W naszym przykładzie posłużymy się nazwą -ibm--medium-r-medium--15-10-100-100-c-70-
iso8859-2. ale w każdym środowisku może być ona inna.  

 
b. Następnie należy stworzyć plik o nazwie SAS (pisanej wielkimi literami!!!) i następującej 

zawartości, podmieniając przykładową nazwę fontu przez tę zapamiętaną uprzednio w 
schowku. 

 
SAS.systemFont: -ibm--medium-r-medium--15-10-100-100-c-70-iso8859-2 

  SAS.DMSFont: -ibm--medium-r-medium--15-10-100-100-c-70-iso8859-2 
SAS.DMSboldFont: -ibm--medium-r-medium--15-10-100-100-c-70-iso8859-2 

 
 
      Plik ten można ściągnąć spod adresu: 

http://www.sas.com/offices/europe/poland/wsparcie/dw/SAS.zip 
 

c. Plik ten można umieścić w dowolnym katalogu, np.: /usr/local/sas 
d. Następnie trzeba ustawić unix-ową zmienną środowiskową XAPPLRESDIR, która będzie 

wskazywać na ten katalog. 
� Bourne shell: XAPPLRESDIR=/usr/local/sas; export XAPPLRESDIR 
� C shell:  setenv XAPPLRESDIR /usr/local/sas 

e. Po uruchomieniu SAS polskie czcionki będą widoczne we wszystkich okienkach SAS.  
 
Jeżeli mimo poczynionych kroków nie widać polskich znaków w już istniejących zbiorach, to 
należy się upewnić czy zostały one przeniesione na platformę UNIX przy zastosowaniu 
odpowiednich tablic translacji (patrz rozdział „3. Connect i Share”.) 
 

6.2. Jak wpisywać polskie znaki w SAS-a? 
      a.    Do wspomnianego w punkcie 6.1.b pliku SAS należy dopisać następujące wiersze: 
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SAS.keyboardTranslations: #override \ 
   Shift Mod1 <Key>a: sas-insert-char(ˇ) \n\ 
   Shift Mod1 <Key>c: sas-insert-char(Ć) \n\ 
   Shift Mod1 <Key>e: sas-insert-char(Ę) \n\ 
   Shift Mod1 <Key>l: sas-insert-char(Ł) \n\ 
   Shift Mod1 <Key>n: sas-insert-char(Ń) \n\ 
   Shift Mod1 <Key>o: sas-insert-char(Ó) \n\ 
   Shift Mod1 <Key>s: sas-insert-char(¦) \n\ 
   Shift Mod1 <Key>x: sas-insert-char(¬) \n\ 
   Shift Mod1 <Key>z: sas-insert-char(Ż) \n\ 
   Mod1 <Key>a: sas-insert-char(±) \n\ 
   Mod1 <Key>c: sas-insert-char(ć) \n\ 
   Mod1 <Key>e: sas-insert-char(ę) \n\ 
   Mod1 <Key>l: sas-insert-char(ł) \n\ 
   Mod1 <Key>n: sas-insert-char(ń) \n\ 
   Mod1 <Key>o: sas-insert-char(ó) \n\ 
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   Mod1 <Key>s: sas-insert-char(¶) \n\ 
   Mod1 <Key>x: sas-insert-char(Ľ) \n\ 
   Mod1 <Key>z: sas-insert-char(ż) 

 
b. Po uruchomieniu SAS należy wybrać z menu ‘Tools*Options*Preferences’, przejść na 

zakładkę ‘Preferences’ i odznaczyć opcję ‘Use menu access keys’ oraz zaznaczyć opcję 
‘Save Settings on Exit’. 

c. Od tej chwili użytkownik będzie mógł wprowadzać w okienkach SAS polskie czcionki jako 
kombinację klawiszy <Prawy-Alt>-<literka> (ewentualnie <Shift> dla wielkich liter). 

 
Jeżeli mimo poczynionych w pkt. 6.2 kroków nie udaje się wpisywać polskich znaków, należy 
sprawdzić konfigurację X-Windows pod kątem opcji dotyczących traktowania klawiszy specjalnych 
lub klawiszy <ALT>. Opcje te zależne są od implementacji X-Windows. 

 
 
7. Zlokalizowane produkty. 
 
Dział NLS naszego biura zlokalizował lub lokalizuje następujące produkty: 
 

a) CFO Vision wersje 2.2, 3.0, 3.1.1 PRODUCTION 

b) AppDevStudio (WebEIS) 1.2, 2.0 PRODUCTION 

c) EG 2.0 TESTING 

d) ER 2.5 SP3 PRODUCTION 

e) MDDB Report Viewer PRODUCTION 

f) Base SAS 8.2, 9.0 PRODUCTION 

g) IDP 1.2 PRODUCTION 
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